Using Autodesk Ecotect Analysis and Building Information Modeling

This document helps you to get the most from Autodesk® Ecotect® Analysis software and building information modeling (BIM).

- Revit® Architecture 2010 software
- Revit® MEP 2010 software

Autodesk building information modeling (BIM) solutions help make sustainable design practices easier, more efficient, and less costly. BIM solutions from Autodesk -- Revit Architecture 2010 and Revit MEP 2010 software – are interoperable with Autodesk Ecotect Analysis software.
## Contents

Autodesk Ecotect Analysis ........................................................................................................................................... 3  
Simplify Sustainable Design Analysis with BIM ......................................................................................................... 3  
  Model Your Building ................................................................................................................................................ 3  
  Revit Architecture BIM Model Development ............................................................................................................. 5  

Revit Architecture 2010 ............................................................................................................................................... 6  
  Adding Revit Room Objects ..................................................................................................................................... 6  
  Checking Room Object Height ................................................................................................................................. 6  
  Changing the Height of Multiple Room Objects ........................................................................................................ 8  

Revit MEP 2010 ............................................................................................................................................................. 9  
  Space and HVAC Zone Objects ................................................................................................................................ 9  
  Adding Revit MEP 2010 Space Objects ....................................................................................................................... 9  
  Checking Space Object Height ................................................................................................................................. 10  
  Changing the Height of Multiple Space Objects ..................................................................................................... 13  
  Adding Revit MEP 2010 HVAC Zone Objects ........................................................................................................ 13  
  Assigning Revit MEP 2010 Spaces to HVAC Zone Objects ................................................................................... 15  

Tips ........................................................................................................................................................................ 16
**Autodesk Ecotect Analysis**

Sustainable design is more important than ever. Building information modeling (BIM) solutions make sustainable design practices easier by enabling architects and engineers to more accurately visualize, simulate, and analyze building performance earlier in the design process. The intelligent objects in the building information model enable the advanced functionality of the desktop and web-based tools that are included with Autodesk Ecotect Analysis software*. Using Autodesk Ecotect Analysis, architects and designers can gain better insight into building performance earlier in the process, helping to achieve more sustainable designs, faster time to market, and lower project costs.

**Simplify Sustainable Design Analysis with BIM**

This section describes the way you would ideally model a building and provides tips that can help you pinpoint problem areas.

**Model Your Building**

Energy analysis requires spatial information—it is essentially a simulation of energy movement in, out, and through the rooms and volumes within a building. Which surfaces are exposed to the outside? How many are exposed to sunlight? What are the number, size, and orientation of openings in each space? How much heat is generated by internal lighting and equipment?

In the past, this information was manually calculated from 2D drawings. An engineer would use building plans, elevations, and details to collate spaces (type, area, volume), surfaces (including adjacency and thermal properties), and shading. All this information is latent in a Revit® model, and in a form that is much easier to interpret than 2D drawings. And, if the project is consistently structured, software such as Autodesk Ecotect Analysis can help take the pain out of the process.

The net result is that a time-intensive task that might only be done once, very late in the design process, can realistically be repeated on demand innumerable times right from the beginning of the project. This is a very important contribution to the design process at a stage when change is still possible.

**Hints and Tips**

One of the most important energy decisions an architect makes is selecting a design scheme.

Autodesk Ecotect Analysis is designed to be used during your scheme selection process to help evaluate every scheme you are considering.

Do not wait until you have made all your design decisions before using Autodesk Ecotect Analysis as it is designed to provide you with the information to help you make informed decisions as they relate to energy-efficient and sustainable designs.

---

1 Customers who add subscription to their Autodesk Ecotect Analysis license get access to the Autodesk® Green Building Studio® web-based service for the duration of their subscription. Access to Autodesk Green Building Studio is subject to the terms of use that accompanies the service. See https://www.greenbuildingstudio.com/default.aspx for details. This User Guide discusses both the Autodesk Ecotect Analysis software product and the Autodesk Green Building Studio web-based service.
There are some crucial things to note, however, and chief among them is creating your building model utilizing the BIM process. Follow these rules to help get the most out of using BIM with Autodesk Ecotect Analysis.

**Create a Revit model very early in your design process.** With Autodesk Ecotect Analysis, a lot of useful information can be gained from even the most basic model. You can begin your analysis with a simple massing model in Revit, with just the basic forms and shapes of your project. This allows you to do overshadowing, incident radiation, and other urban-scale calculations. As your design progresses, you can create forms with approximately the right glass area on each façade, but do not worry about the details of window sizes. For schematic purposes, a continuous ribbon of glass that has the same area as a series of punched windows provides enough detail to make decisions about glass area. Then, as you begin to add floors and internal spaces within the model, you can use whole-building energy analysis as a way of comparing design options and investigating the best opportunities for improved performance.

**Do not use Revit®-based software like a 2D CAD tool.** This oversight generally occurs when users are looking for a set of construction documents (CDs)—floor plans and details. Consequently, floors, ceilings, roofs, sill heights, and so forth may not be modeled as they are not required in typical CDs. However, inclusion of these elements in your BIM model is crucial to the successful use of these analysis tools.

**Model floors, ceilings rooms, and roofs, in addition to walls and windows.** These are essential items when it comes to whole-building energy analysis and more detailed thermal simulations.

**Model the windows and skylights that are possibilities.** Glazed areas contribute the most to HVAC energy use. Do not worry about getting window and skylight sizes exactly right as you can quickly resize, remove, or optimize them within Autodesk Ecotect Analysis.

**Model significant spaces only.** Do not spend time modeling small spaces, storage spaces, phone closets, and so on that will increase simulation time and model complexity, but not increase accuracy of your results. Think of your building in the context of space uses and placement. For example, create “rooms” that are on the perimeter of the building (approximately 15-feet deep), add core “rooms,” and only partition the interior if the core becomes very large or is influenced by the nearby perimeter.

**Connect all walls, roofs, slabs, and ceilings.** Be sure that your walls connect to each other as well as to their respective slabs, ceilings, and roofs. Do not leave gaps in your model.
Revit Architecture BIM Model Development

Autodesk Ecotect Analysis is designed to be used during the conceptual and early stages of the design process to help ensure resource use information relating to energy, water, and other metrics is available and used during the scheme selection process. With this in mind, we recommend you keep your model as simple as possible. We recommend you only model major spaces and combine smaller spaces that represent key programmatic requirements of the project. Do not include all interior partitions that will eventually be part of the final building.

Adding more interior partitions than is required will create more work in the model, introduce potential errors, and slow the simulation without significantly improving the accuracy of the results.

If you are familiar with a thermal zone layout of a building, we recommend your room layout be similar. Perimeter rooms facing the same direction should be grouped together. Core zones with little or no exterior exposure should be grouped together.

Similarly, unconditioned support spaces, such as restrooms, stairwells, elevator shafts, and storage spaces, should be grouped together. Work with your mechanical engineer for guidance on such a layout if you are not familiar with it.
Revit Architecture 2010
Your Revit Architecture software model must have room objects defined for all rooms or group of rooms that you want to be exported to green building extensible markup (gbXML) and analyzed by Autodesk Ecotect Analysis. You must ensure that the room object is positioned properly in the model and that the room is high enough to “touch” a bounding surface. In the next few pages we will describe how you can ensure the room object is being used correctly.

Adding Revit Room Objects
Revit Architecture allows you to add room objects to your model at any time. It is fairly easy, but a new concept for most regular users of CAD.

Open a plan view of the level you want to add rooms.

Select the room object from the Home tab.

Click in the center area of the model area where you would like a room to be defined. Revit Architecture then highlights all the bounding walls that make up the room boundaries for the newly added room.

All rooms should be in the New Construction phase. Under the Manage tab, choose Phases... and then combine all phases into New Construction.

Checking Room Object Height
The best way to view a Revit Architecture room object’s height is viewing it in section. First you have to ensure the visibility of the room object’s Interior Fill is selected.

You can access the Visibility/Graphic Overrides dialog box using the View tab and selecting Visibility/Graphics.

Once you have enabled the Interior Fill for Rooms to be visible, you will see the room object in section view.

Figure 1—Autodesk Revit Architecture Visibility/Graphic Dialog

Hints and Tips
Room objects will be placed at the level on which you are working. By default the upper limit and the level will be the same. Default room height is captured using the Limit Offset and is typically 8 feet.

Take advantage of the Autodesk Revit Architecture parametric capabilities, and use the level above your current level as the upper limit rather than relying on the limit offset. If levels are later changed, the room height will be automatically adjusted, and you will not have to individually modify each room’s height.
If your room object is not touching the entire roof or ceiling in the room, then not all of that roof or ceiling will be exported to the gbXML file. By default, the room height is 8-feet above the base level. The file will still run but will not be thermally correct. Figure 2 illustrates room objects on the lower floor that are incorrect because they are not in contact with the ceiling.

The room objects on the second floor are incorrect because they are not in contact with the roof. Walls, roofs, columns, curtain systems, building pads, and room separator lines can be made to be room bounding objects by changing element properties. Floors and ceilings are always room bounding.

The way to fix these types of issues is to select the room object by right-clicking the X over the room object when it appears, and selecting the Properties menu item as seen below.

In the properties window for the room, change the Upper Limit to the level of the roof or ceiling and add a Limit Offset, if necessary, to increase the room object height to enclose the entire roof. Then go back to the section view to confirm the roof or ceiling is now fully enclosed in the room object. Figure 3 illustrates the room object now correctly defined. The rooms on the lower floor are now in contact with the ceiling, and the rooms on the upper floor are fully in contact with the roof. Although the upper-floor rooms graphically extend above some of the roof surfaces, the room volumes will still be computed correctly.
Changing the Height of Multiple Room Objects

The best way to change multiple room heights is to select them all on a floor plan. In the Floor Plan view, select all items on that floor by clicking and dragging the selection box over the entire floor or area of desired rooms. Click the Filter button from the Multi-Select tab. Then uncheck all items except the Rooms on the Filter dialog.

At this point, all rooms from your selection will be selected. Right-click on a selected room object and select Properties from the menu. Set the Upper Limit and Limit Offset to the desired values.

You can also change the height of several room objects by creating a Room Schedule that includes the Room Name, Level, Upper Limit, and Limit Offset. Then edit the Upper Limit and the Limit Offset in the Room Schedule as needed.
Revit MEP 2010

Space and HVAC Zone Objects
Unlike Revit Architecture 2010, Revit MEP 2010 software does not require the definition of rooms for successful analysis with Autodesk Ecotect Analysis; however, Revit MEP models must have space and HVAC Zone objects defined.

You must manually add space objects within your project. By default, Revit MEP will automatically create one HVAC Zone for the entire building and assign all of your spaces to that HVAC Zone. You must manually create additional HVAC Zones if appropriate for your project.

When exported to the Autodesk Green Building Studio web-based service, the gbXML file automatically groups multiple spaces assigned to one HVAC Zone into one space (this is due to the limitations of the DOE-2.2 simulation engine used by the web service). This may not be problematic for your project unless you have a mixture of conditioned and unconditioned spaces grouped together under one HVAC Zone. The Autodesk Green Building Studio analysis will be unable to properly analyze mixed conditioning types within one HVAC Zone. In order to retain the proper condition type (conditioned, unconditioned, and so on) for your spaces, you must assign spaces of similar condition type to each HVAC Zone within Revit MEP 2010. This topic will be covered in more detail in the section below called “Adding Revit MEP 2010 HVAC Zone Objects.”

Adding Revit MEP 2010 Space Objects
After adding the space object, you must ensure that it is positioned properly in the model for the best results. Over the next few pages we will describe how you can ensure the space object is being used properly. The process for defining space objects in Revit MEP is very similar to the process for defining room objects in Revit Architecture.

1. Open a plan view of the level you want to add spaces.  
2. Select the space object from the Analyze tab.  
3. Click in the center area of the model area where you would like a space to be defined.

Revit MEP should then highlight all the bounding walls that make up the space boundaries for the space you just added.
Checking Space Object Height

The best way to view a Revit MEP space object’s height is to view it in section. First you have to ensure the visibility of the space object’s Interior Fill is selected. You can access the Visibility/Graphic Overrides dialog box using the View tab and selecting Visibility/Graphics.

![Revit MEP Visibility/Graphic Dialog](image)

Figure 4—Revit MEP Visibility/Graphic Dialog
Once you have enabled the Interior Fill for spaces to be visible, you will see the space object in section view.

Figure 5—Revit MEP 2010 Section View: Height of Space Objects Incorrectly Defined

If your space object is not touching the entire roof or ceiling in the room, then not all of that roof or ceiling will be exported to the gbXML file. Figure 5 above illustrates that the space objects on the lower floor are incorrect because they are not in contact with the ceiling. The space objects on the second floor are incorrect because they are not in contact with the roof.

Walls, roofs, columns, curtain systems, building pads, and room separator lines can be made to be room bounding objects by changing element properties. Floors and ceilings are always room bounding.

To fix these types of issues, select the space object by right-clicking the X over the space object when it appears, and then select the Properties menu item, as seen here.
In the Element Properties window for the space object, change the Upper Limit to the level of the roof or ceiling and add a Limit Offset that will increase the space object height to enclose the entire roof. Then go back to the section view to confirm the roof or ceiling is now fully enclosed in the space object. Figure 6 below illustrates the space objects now correctly defined. The spaces on the lower floor are now in contact with the ceiling and the spaces on the upper floor are fully in contact with the roof. Although the upper-floor spaces graphically extend above some of the roof surfaces, the space volumes will still be computed correctly.

Figure 6—Revit MEP 2010 Section View: Height of Space Objects Correctly Defined
Changing the Height of Multiple Space Objects

The best way to change the height of multiple spaces simultaneously is to select them all on a floor plan. In the Floor Plan view, select all items on that floor by clicking and dragging the selection box over the entire floor or area of desired rooms. Click the Filter button from the Multi-Select tab. Then uncheck all items except Spaces on the Filter dialog.

At this point all spaces from your selection will be selected. Right-click a selected space object, and select Properties from the menu. Set the Upper Limit and Limit Offset to the desired values. That is it.

You can also change the height of several space objects by creating a Space Schedule that includes the Space Name, Level, Upper Limit, and Limit Offset. Then edit the Upper Limit and the Limit Offset in the Space Schedule as needed (see below).

<table>
<thead>
<tr>
<th>Space Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td>Kitchen</td>
</tr>
<tr>
<td>Dining Room</td>
</tr>
<tr>
<td>Living Room</td>
</tr>
<tr>
<td>Bath</td>
</tr>
<tr>
<td>Master Bedroom</td>
</tr>
<tr>
<td>Family Room</td>
</tr>
<tr>
<td>Bedroom</td>
</tr>
<tr>
<td>Study</td>
</tr>
<tr>
<td>Bedroom</td>
</tr>
<tr>
<td>Washroom</td>
</tr>
<tr>
<td>Bath</td>
</tr>
<tr>
<td>Game Room</td>
</tr>
</tbody>
</table>

Adding Revit MEP 2010 HVAC Zone Objects

Revit MEP 2010 software automatically creates one HVAC Zone for the entire project and names it Default. You can verify this by creating an HVAC Zone Schedule (see below). The Level category is blank in this example because the Default HVAC Zone encompasses all the spaces on multiple levels of this project.

In order to verify which spaces are associated with which HVAC Zones:

1. Select the Analyze Tab
2. Select System Browser
3. Right-click on the System Browser window
4. Choose View
5. Select Zones

In the example below, you can see that there are 18 spaces within the Default HVAC Zone. You may export your file to the Autodesk Green Building Studio web-based service at this point; however, the gbXML file will group multiple spaces assigned to each HVAC Zone into one space (this is due to the limitations of the DOE-2.2 simulation engine used by Green Building Studio).

The Green Building Studio simulation will run if your project consists of only conditioned spaces grouped together under one HVAC Zone. However, it is usually not reasonable to combine all the spaces in a building into one thermal HVAC Zone and will typically cause inaccurate results. If your project contains a combination of conditioned and unconditioned zones, and in order to retain the proper conditioning type of your spaces for the Green Building Studio analysis, you will need to group conditioned spaces together in conditioned space zones, and unconditioned spaces together in unconditioned space zones.
Assigning Revit MEP 2010 Spaces to HVAC Zone Objects

To create an HVAC Zone, go to the Analyze tab and choose Zone. A small Zone window will appear with three icons plus Finish and Cancel buttons. In the example below, the HVAC Zone has automatically been named 2. To add a space to the HVAC Zone 2, move your cursor over the appropriate space, left-click, then click the Finish button. To add multiple spaces to one HVAC Zone, continue clicking on the desired spaces before clicking the Finish button. Revit MEP 2010 will automatically name your new HVAC Zones beginning with the numeral 1.

If you choose to rename the HVAC Zones, you can do so by creating an HVAC Zone Schedule and editing the HVAC Zone name within the Schedule.

Hints and Tips

Your HVAC Zone name must not contain any spaces within the text or the Green Building Studio run will fail. For example, the name “Zone 1” will cause the Green Building Studio run to fail, but the name “Zone1” will run successfully.
Tips

- At the earliest “massing” stages of design, you can export your model as a DXF™ file to get just the external geometry of the building forms. With just this level of detail you can do many different types of surface and exterior urban design studies using the Ecotect Analysis desktop functionality.

- To begin whole-building energy analysis, add each storey of your building as a single space and define glazing areas in the Revit model as “ribbons” of glass around the building, rather than individual punched windows. This is easier to model in Revit Architecture or Revit MEP, and it will reduce the simulation time and provide enough accuracy to analyze the energy impact of different glazing schemes.

- Once you have stories and spaces defined, you can export your model as a gbXML file to use these in your analysis.

- If importing the gbXML file to the Autodesk Green Building Studio web-based service produces a message stating that horizontal surfaces are missing, it is likely caused by room objects not being in contact with the surfaces above them. Adjust room or space objects accordingly. See the Revit Architecture 2010 Room Object section for further details.

- While using Revit Architecture, plenums and other interstitial areas should have a room object placed in them for them to be properly exported to gbXML. Any room or space less than 2-meters high or whose lower bound is a ceiling is assumed to be unconditioned.

- While using the Green Building Studio web-based service, if the DOE-2 file is opened in eQUEST and there are several shades on the roof, it is because the upper limit of the room objects on the top floor is not high enough to encompass the roof. To solve this, extend the room object’s top surface to above the roof’s top surface (as shown here).

- Revit Architecture Settings:
  - Group All Project Phases under New Construction (Manage>Project Information>Energy Data)
  - Enable Area and Volume Computations (Home>Room and Area>Area and Volume Computations>Computations)

- Include room objects (RAC) or space objects (RME).

- Only surfaces in contact with the room/space object will be exported to gbXML. Room (RAC) or space (RME) object heights need to fully enclose the peak of the roof (exceeding roof is okay). If not in contact with surfaces, surfaces will be exported as a shading surface.
• Model floors and roofs in addition to walls and windows.
• Use only Roof, Wall, Floor, Ceiling, Door, and Window Families as appropriate for the surface type. Custom families do not export to gbXML.
• Linked files may not properly export to gbXML.
• *Keep it simple!* Remember this is meant for schematic design.
• Once you have experimented with different options in the Autodesk Green Building Studio web-based service, you can begin detailed studies using desktop tools in Autodesk Ecotect, focusing on specific parts of the building or even on individual windows. This way you can build and analyze detailed models of shading devices or light redirection systems.
• Similarly, with a highly detailed model, you can check that design metrics such as daylight levels and visual access requirements are still being met.
• HVAC zones encompassing more than one level may trigger an error message “FLOOR … has no SPACE” when submitted to the Green Building Studio web-based service. It is recommended that your model not contain multi-level HVAC zones, if possible.